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1. Portfolio Swap Definition

1.1 Overview
A portfolio swap is an agreement between a buy-side and sell-side institution that helps standardizing the handling of
equity swaps. For swaps within the portfolio, the performance and financing resets occur at the same time. Portfolio
swaps provide synthetic long or short exposure that is equivalent to buying and short selling a basket of shares on
margin.

Positions
A portfolio swap allows a client to trade in and out positions within the swap, and do so any number of times during
the lifetime of the contract. The swap is dynamic; therefore, its positions will increase or decrease based on trading
activity booked to the swap. A client may, at any time, unwind any of its positions with the portfolio, or its entire
portfolio. The liquidation method is part of the pre-agreed information in the portfolio swap contract.

Portfolio swaps settle in a pre-agreed currency. So, for example, a client could set up a UK Portfolio Swap settling in
GBP, or a German and French portfolio settling in EUR. A portfolio swap is traditionally a long dated instrument, often
with a duration between two and seven years.

Once a Portfolio Swap on a specific underlying security is open, regardless of whether it is held long or short, the
holder can add additional quantities (trades) of the same underlying security at a market price. At any time, a swap
holder can partially or fully terminate/liquidate the position. Any trade that is in the opposite direction (BUYS and
SELLS) of the underlying position will result in a close out/liquidation. Close-out trades are matched against one or
more open trades using the relevant liquidation method (defined in the contract).

The contract and the underlying security will be part of the basic liquidation criteria. Therefore, there will be one
position per contract, underlying security and book. The liquidation gives rise to realized trading gains or losses if the
open price and close price are different. The same liquidation method is used for all individual trades booked under
the same contract.

Refer to the Calypso Positions Management User Guide for details on starting the Liquidation engine and for more
information on the liquidation configuration.

Access Permissions
The Portfolio Swap access permissions include:

• ViewPortfolioSwapContract: Portfolio Swap Contract viewing restriction

• ModifyPortfolioSwapContract: Portfolio Swap Contract editing restriction

1.2 Defining a Portfol io Swap Contract
From Calypso Navigator choose Configuration > Equity > Portfolio Swap Contract (menu action
refdata.PortfolioSwapContractWindow) to open the Portfolio Swap Contract window.
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Sample Portfolio Swap Contract

1 .2 .1 Loading an Exist ing Port fo l io Swap
You can load an existing portfolio swap in the Portfolio Swap Contract window using one of the following methods:

» Enter a value in the Id field.

» You can also click to view a list of the saved portfolio swaps.

Nasdaq Calypso
Portfolio Swaps / Version 18



1 .2 .2 Creat ing a New Port fo l io Swap Contract

» Click and configure the fields described in the table below.

» Click to save changes. You can click to save as new.

Note that if the Authorization mode is enabled, an authorized user must approve your entry, provided that
"PortfolioSwapContract" has been added to the classAuthMode domain.

Duplicate Contracts
While saving a new contract, the system can be configured to check if a similar contract already exists. You need to
define the fields to be checked in the domain “duplicateContractFields” – The fields can be StartDate, EndDate,
ProcessingOrg, CounterParty, SettlementCurrency, MarketType, FXConversion, PayAccrualsAtLiquidation,
LiquidationMethod, CommissionPayMethod, TradingGainPayMethod, DividendPayMethod, CashCollateral.

If an existing contract has the same values for these fields, a warning is displayed and you can choose to create the
new contract or not.

Contract Details

Fields Description

Processing
Org

Select the processing organization. The processing organization is a legal entity with the role
ProcessingOrg.

Way Choose PROVIDER or USER.

The provider receives trading commissions on buy and sell trades. The user pays the trading
commissions.

Each contract must have one provider and one user.

Counter Party Select the counterparty of the contract.

Status Select Active or Inactive. You can only capture trades against Active contracts.
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 Ⓘ [NOTE: It is possible to have multiple contracts between the same processing organization and
counterparty during a particular period of time]

General Terms Field Details

Fields Description

Market Type Select a particular market type or ALL. Selecting a particular market type enables the Location field
and provides an option for specifying values.

• All - Any security can be traded under the contract.

• Exchange - Only the equities of the exchanges defined in the Location field can be traded under
the contract.

• Country - Only the equities of the countries defined in the Location field can be traded under the
contract.

• Region - Only the equities of the regions defined in the Location field can be traded under the
contract.

See Regions section below for information on defining regions.

Start Date Specify the start date of the contract.

End Date Specify the end date of the contract.

Settlement
Currency

Select the currency used for all types of settlements (Performance, Funding, Dividend, Commission,
etc.). All individual trades booked under the same contract will use the same settlement currency.

Usually, the settlement currency is the same as the funding rate index currency.

FX
Conversion

Select the FX Conversion method for multi-currency positions (underlying security currency is
different from the contract settlement currency).

• Flexo - Not currently supported.

• Compo: All flows, pricing, and P&L measures are provided in contract settlement currency. The
FX conversion is done at each price fixing.

Pay Accruals
At Liquidation

Select one of the following options:

• Initial Schedule - Accruals are paid at the next payment date according to the initial payment
schedule.

• Effective Date - Accrual is paid on the liquidation date + the payment date lag.

If you select Effective Date, please select Effective Date for Trading Gain Pay Method as well.

Liquidation
Method

Select the method of liquidation to be applied on all trades/positions booked under the contract.

It is recommended to use FIFO.

Average Price liquidation is supported with the following constraints:

• Date Calculation Method = Fixing > Payment Date

Nasdaq Calypso
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Fields Description

• Trade Level Spread functionality is not supported

• Lag between Trade Date and Settle Date should be same across all trades

Commission
Pay Method

Select the method for paying commissions to the provider of the contract.

• Upfront Fee (bps) - The upfront commission fee is based on the trade notional.

• Upfront Fee (amount per share) - The upfront commission fee is based on the trade quantity.

• Embedded in Price (bps) - The commission fee is embedded in the funding notional of the trade.

• Embedded in Price (amount per share) - The commission fee is embedded in the initial price.

Trading Gain
Pay Method

Select the method for paying the trading gain.

• Effective Date - Trading gain is paid on the liquidation date.

• Perf Schedule - Trading gain is paid according to the performance schedule.

• Funding Schedule - Trading gain is paid according to the funding schedule.

• At Maturity - Trading gain is paid at the maturity of the contract.

Dividend Pay
Method

Select the method for paying dividends.

• None - No dividend is paid/received.

• At Maturity - The dividend is paid/received upon the end date of the contract.

• Perf Schedule - The dividend is paid/received on the next performance payment date following
the dividend payment date.

• Upon Receipt - The dividend is paid/received on the dividend pay date + Dividend Date Lag.

Basic Interest If checked: Basic Interest charges (service charges) are paid by the user of the contract according to
the funding schedule.

If unchecked: no Basic Interest charges are to be paid by the user.

Cash
Collateral

If checked: the Cash Collateral tab is added to the Portfolio Swap Contract window (click on the Cash
Collateral tab for details). Cash collateral measures are generated for the position aggregations on
the contract level.

If unchecked: the Cash Collateral tab is disabled and no cash collateral measures are generated.

Underlying
ProductType

You can select the type of underlying product supported for this contract or All for all product types.

Available product types are specified in domain "PFSContractUnderlying".

Date Cal-
culation
Method

Select the method to determine the settlement lag:

• Independent (default upon upgrade) – There is no link between the Equity leg and the Funding
leg (legacy logic).

• Fixing > Payment Date - Settlement Lag on Equity leg is set in Payment Date Lag field. Fixing
Date Lag on Equity leg is null and not editable. Reset Lag on Funding leg is editable. Payment
details on Funding leg are based on Equity leg and are not editable.

Nasdaq Calypso
Portfolio Swaps / Version 18

December 2024
Revision 2.0 / Approved

Proprietary and Confidential
Page 8 / 41



December 2024
Revision 2.0 / Approved

Proprietary and Confidential
Page 9 / 41

Fields Description

• Payment > Fixing Date - Settlement Lag on Equity leg is set in Fixing Date Lag field. Payment
Date Lag on Equity leg is null and not editable. Reset Lag on Funding leg is editable. Payment
details on Funding leg are based on Equity leg and are not editable.

Attributes Click to add new attributes. Attributes are displayed in the Attributes pane. A value can be added
for each attribute.

FX Resets Enter FX Resets references for multi-currency positions.

Regions
To provide region functionality to the Locations field under Market Type on the General Terms tab, perform the
following steps.

Define regions under the CountryAttributes.Region domain, as shown below.

Define Region under the CountryAttributes domain, as shown below.
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Select / configure the appropriate Region at the Country Attributes level:

From Calypso Navigator choose Configuration > Definitions > Countries to open the Country window.

» Click the Attribute link on the Details tab to open the Attributes Window.

» Click Domain .... The CountryAttributes Domain window opens.
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Add Region to the list of attribute names and click OK. Pre-defined regions are now available as values in the
Location field of the General Terms tab.
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1.3 Specifying Equity Leg Detai ls
Select the Equity Leg Details tab.

» Configure the fields described in the table below as necessary.

» Click Generate Schedule to generate the equity leg schedule.

Equity Leg Details

Fields Description

Performance
Schedule

Choose the performance payoff schedule.

• AT_MATURITY: The final performance payoff occurs on the end date of the contract.

• CUSTOM_SCHEDULE: Configure the fields below to specify the payoff frequency.

Select a payoff frequency, a roll day for weekly and monthly frequencies, stub rule, and period
rule.

The Period Rule can be ADJUSTED or UNADJUSTED to determine if the end date of a payoff
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Fields Description

period is adjusted when it falls on a non-business day (applicable with BUS lag payment). Other
options include FRN and MAT_UNADJUSTED.

• DATE_RULE: Select a date rule for generating the payoff schedule.

For the fixing date lag, the default is zero business days.

Payment
Date Lag

Specify the number of days to offset the payment, whether the payment is based on business or
calendar days, holidays, and date roll.

Apply roll on
day Lag

When Apply roll on day Lag on Cmp Cashflows checkbox is checked, lag will be applied on the
compounded cashflow dates calculated based on Roll On Day and Roll on Day Lag (derived from
payment date lag on equity leg) field to get desired / adjusted dates and a new field of Roll on Day
Lag will be visible on the funding leg below Roll on Day.

Nasdaq Calypso
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1.4 Specifying Funding Leg Detai ls
Select the Funding Leg Details tab and keep the new field "Different Rate Index for Long and Short" unchecked
(default behavior).

» Configure the fields described in the table below as necessary.

» Click Generate Schedule to generate the funding leg schedule.
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Funding Leg Details

Fields Description

Different Rate
Index for Long
and Short

Leg Type

Check to define a different funding rate for long positions in the Long Rate Index tab and short
positions in the Short Rate Index tab, or clear otherwise (the funding leg defined in the Long Rate
Index tab applies to both Long and Short positions).

Select Fixed or Float.

Fixed Rate (%) Enter the percentage rate when Leg Type is Fixed.

Rate Index

Reset Frequency

Reset Lag

Reset Timing

RoundingMethod

When Leg Type is Float:

» For Rate Index, select the Currency, Name, Tenor, and Source.

» For Reset Frequency, select NO if it is the same as the payment frequency, or select the
reset frequency if it is more frequent than the payment frequency.

For example, select DLY for daily compounding rate indices.

» For Reset Lag, specify the number of days between the reset date and the payment period
end date, bus / cal days, holidays and date roll.

Use Observation Shift Period - When checked, it includes an Observation Shift that allows
shifting the whole Sample Period in addition to the Reset Dates, such that the weights of any
given daily fixing remains the same.

» For Reset Timing, select BEG_PER / END_PER. The rate is reset at the beginning / end of the
coupon period.

» For RoundingMethod, select the rounding method and the number of decimal places.

Compounding Check Compounding to enable compounding and specify the following fields as needed.

Frequency - It is set to the reset frequency. For WK/BIWK/LUN, you can select Original or
Regular. Difference between Original and Regular (Example for a 3M swap paying MONTHLY
compounding WEEKLY):

• Original splits the 90 days into periods of 7 days and puts the remaining as STUB.

• Regular splits the 90 days into 3 periods of 30 days each, and then splits the 30 day periods
into periods of 7 days thus leaving stubs on each coupon period.

Compounded cashflows with reset frequency higher than payment frequencies for IBOR rate
indices is supported with Compounding Method = NoCmp.

Cutoff Lag - Only available for DLY frequency. You can enter a number of days for the cutoff lag,
bus / cal days and holidays.

Sample Timing - Only available for DLY frequency. Select BEG_PER / END_PER.

Method - The only available method currently available is NoCmp. A cashflow is created at the
compounding period without actually compounding the interest. The daily rate resets for the
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Fields Description

floating rate are used to calculate the simple interest everyday and summed to find the total
interest for the period.

Diff. Reset Date - Check to generate the reset dates based on the coupon frequency. It uses the
index tenor otherwise.

Multiplicative Spread - Check "Multiplicative Spread" so that the spread over the rate index is
multiplicative rather than additive.

Daycount Specify the day-count convention.

Daycount defaults to the day count of the Rate Index.

See Calypso Navigator > Help > Day-Count Conventions for descriptions of the day-count
conventions.

DiscountMethod You can select NONE for no discount, or EXP for exponential interest calculation.

 Ⓘ [NOTE: The EXP discount method is only supported for contracts with Date Calculation
Method = Independent]

Frequency Select the payment frequency and configure Roll On day and Payment At options. Roll On Day
can be set by the user to generate desired compounded cashflows dates.

Stub Rule Select the rule to apply in case of a stub period and configure the stub rule as needed.

Period Rule Select an adjustment method.

• ADJUSTED: Adjusts the period's end date if it falls on a non-business day, according to the
payment date roll convention. ADJUSTED is set as the default for the Period Rule field.

• FRN: Adjusts the period's end date to the next business day if it falls on a non-business day,
unless the next business day is in the following month, in which case the preceding business
day is used.

• MAT_UNADJUSTED: Adjusts the period's end date if it falls on a weekend, unless it is the last
period (maturity), in which case it is not adjusted; as such, the adjustment method may affect
intermediate amounts, but it does not change the maturity date.

• UNADJUSTED: Does not adjust the period's end date for non-business days.

Payment Date
Lag

Specify the number of days to offset the payment, bus / cal days, holidays and date roll.

First Accrual If checked, the notional to be used for the basic interest, funding and borrow charge calculation
is the current day notional. It means that the interest accruals on the start date correspond to 1
day of accrual.

If unchecked, the notional used for the basic interest, funding and borrow charge calculation is
the previous day notional. There is no accrual on the start date.

Include Cash

Prepaid

If checked: Cash margin call position is included in the funding flow calculation. The funding is
paid by the user of the portfolio swap contract regardless of the direction of the position.
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Fields Description

If unchecked: Cash margin call position is not included in the funding flow calculation.

Borrow Charge If checked: Borrow charge flows are paid by the user of the portfolio swap contract on short
positions.

If unchecked: Borrow charge flows are not paid.

Allow Trade Spe-
cific Funding
Spreads

If checked: Funding spreads can be edited at trade level for all trades associated with the
contract.

If not checked: The contract information is used to calculate the funding spreads.

Allow Trade
Specific Reset
Rate

If checked: The trade settle date reset date will be used for accrual calculations.

1.5 Country Grid
Select the Country Grid tab.

» Click to add a new row. To delete a row, select the row and click . To delete all rows, click .

» Configure the fields described in the table below as necessary.

» If "Allow Trade Specific Funding Spreads" is checked, and the funding spreads are modified, you will be prompted
to propagate them to the associated trades.

Click Yes and run the scheduled task UPD_TRADES_PFS_RERATE to actually propagate the funding spreads to
the trades. It will set the portfolio contract attribute RERATE_SPREAD_PROPAGATED = YES.

Nasdaq Calypso
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You can select a contract, or leave empty for all.

Country Grid Details

Fields Description

Version When the first version of the country grid is saved, the version number defaults to 0.

You can click to create a new version of the existing rules. In this case, the existing rules are
duplicated and the version number is increased.

When a trade is created, the latest version of the rules is used and is stored in the trade keyword
PortfolioSwapPositionSpreadVersion.

Country Select the country of the product or Any.

Security
Type

Select a product type or Any. It is limited to product types selected in “Underlying ProductType” in the
General Terms tab.

Security Click ... in the Security field and navigate the Product Chooser window to select a product, or leave as
Any.

Start Date The start date of the period to which the country grid applies.

End Date The end date of the period to which the country grid applies.

Long
Commission
(bps)

Short
Commission
(bps)

Enter the default commission rates for trade activity. The commission rate is applied to all trades
booked under a particular portfolio swap contract. The Long Commission is paid/received on buy
trades. The Short Commission is paid/received on sell trades.

A fee of type COMMISSION is computed upon saving the portfolio swap trades.
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Fields Description

Receivable
Dividend (%)

Payable
Dividend (%)

Enter the dividend retrocession rate applied on long and short positions. Receivable Dividend is the
percentage of the dividend received by the processing organization on a long position. Payable
Dividend is the percentage of the dividend paid by the processing organization on a short position.

Long
Funding
Spread (bps)

Enter a funding spread to be applied on long positions.

Short
Funding
Spread (bps)

Enter a funding spread to be applied on short positions.

Borrow
Charge
Spread (bps)

Enter a Borrow Charge Spread to be applied on the user's long positions. In the Corporate Action
calculation, the Borrow Charge Spread is added to the Borrow Charge Rate for calculating the Borrow
Charge accrual and CA amount.

Hair Cut (%) Enter a haircut percentage as needed. It is used in the Funding calculation if Include Cash Prepaid is
unchecked on the Portfolio Swap contract. Funding Notional = Cost Notional * Hair Cut %.

1.6 Lifecycle Actions
You can use the Lifecycle Actions tab to define lifecycle actions for the contact.

Defining a Termination
Check the Termination checkbox and enter the Termination Date.

Check "At Average Price?" to terminate the trade at average price, or market price otherwise.

Save the contract.

To perform the actual termination of the contract, you need to generate the corporate actions on the termination date.
A corporate action of type REDEMPTION.TERMINATION is created.

When applying the corporate action, the positions on the contract are terminated at the underlying market price (or
average price if "At Average Price?" is checked). The status of the contract is changed to Terminated and no new
trades can be entered on the contract.

Nasdaq Calypso
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Please refer to Calypso Portfolio Swaps Corporate Actions documentation for complete details.

Defining a Rollover
Check the Rollover checkbox and enter a Rollover Date.

Check "At Average Price?" to roll over the trade at average price, or market price otherwise.

Then click Select Contract to select the target contract where the current contract needs to be rolled over. You can
only select a contract with the same FX conversion method.

Save the contract.

To perform the actual rollover of the contract, you need to generate the corporate actions on the rollover date. A
corporate action of type TRANSFORMATION.ROLLOVER is created.

When applying the corporate action, the positions on the current contract are terminated at the underlying market
price (or average price if "At Average Price?" is checked) and new positions are created on the target contract. The
status of the current contract is changed to RolledOver and no new trades can be entered on the current contract.

Please refer to Calypso Portfolio Swaps Corporate Actions documentation for complete details.

1.7 Cash Col lateral
The Cash Collateral tab is enabled when the Cash Collateral checkbox is selected on the General Terms tab.

» Select the Cash Collateral checkbox on the General Terms tab.

» Configure the fields described in the table below as necessary.

Cash Collateral Details

Fields Description

Margin Call Contract Select a margin call contract that applies to the portfolio swap contract.

 Refer to Calypso Collateral documentation for details on defining and creating a
margin call contract.

Start Date The start date of the period to which the ratios apply.

End Date The end date of the period to which the ratios apply.
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Fields Description

Initial Margin Ratio (%) Enter the initial margin ratio used in margin call measures calculation.

Maintenance Margin Ratio
(%)

Enter the maintenance margin ratio used in margin call measures calculation.

Pre agreed % for cash
withdrawal

Enter the pre-agreed % for cash withdrawal used in cash balance measures
calculation.

FX Reset If needed, select an FX Reset reference for FX conversion of the margin call position.

1.8 Extending the Maturity Date of the Contract
You can extend the maturity date of the contract using Reconvention > Maturity Date Change.

It brings up the Maturity Date Change reconvention window.

Enter the Reconvention Date and Time, Effective Date and Maturity Date.

Then click Apply.

The reconvention appears in the Reconvention panel of the General Terms tab.

Save the contract.

The contract end date does not change but new trades and lifecycle actions are applicable until the new end date.
The column "Extended Maturity Date" allows viewing the new end date in the Trade Browser.

For trades with ADR, Equity, Equity Index underlyings - All trades existing before the reconvention keep their original
end date. Trades entered after the reconvention effective have the new end date.
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For trades with Future Equity Index underlyings – The end date is set to the minimum of the contract end date and the
future expiration date. All trades existing before the reconvention keep their original end date. Trades entered after
the reconvention effective date have the end date set to the minimum of the mew end date and the future expiration
date.

Country grids are extended to the new end date.

Cashflows are generated up to the new end date with Short Last stub rule.
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2. Capturing Portfolio Swap Trades
This document describes how to capture portfolio swap trades using the Trade Portfolio Swap Window.

Portfolio Swap Quick Reference

Under ly ing Conf igu ra t ion
» To preconfigure a portfolio swap trade, navigate to the Portfolio Swap Contract

window: Calypso Navigator > Configuration > Equity > Portfolio Swap.

Ente r ing Trade Deta i l s
» When you open a trade worksheet, the Trade tab is active by default.

» You can select a template from the Template drop-down list to populate the worksheet
with default values, and then modify the fields as applicable.

You can also enter the trade fields manually. They are described below.

» Proceed to other tabs as applicable.

Sav ing a Trade
» Press F5 to save the trade, or select Trade > Save from the menu bar.

You can also press F3 to save the current trade as a new trade, or select Trade > Save
As New.

A description appears in the title bar of the trade worksheet, a trade ID is assigned to
the trade, and the status of the trade is modified according to the workflow
configuration.

2.1 Sample Portfol io Swap Trade
Select Calypso Navigator > Trade > Equity > Portfolio Swap (menu action
trading.TradePortfolioSwapPositionWindow) to open the Trade PortfolioSwap Window.

Nasdaq Calypso
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Trade Details

Fields Description

Role /
Cpty

The first two fields of the worksheet identify the trade counterparty.

The counterparty's role is displayed next to the counterparty field. Double-click the label to change the
role.

You can select a legal entity of the specified role provided you have set up favorite counterparties.
Double-click the Cpty label to set the list of favorite counterparties. You can also type in a character to
display the favorite counterparties that start with that character.

Favorite characters are specified using Utilities > Configure Favorite Counterparties.

Otherwise, click ... to select a legal entity of specified role from the Legal Entity Chooser.

Book Trading book to which the trade belongs. Defaults to the book selected in the User Defaults. You can
modify as applicable.
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Fields Description

The owner of the book (a processing organization) identifies your side of the trade.

You can select a book provided you have set up favorite books.

Status Current status of the trade. The status is automatically assigned by the system based on the workflow
configuration.

The status will change over the lifetime of the trade according to the workflow configuration and the
actions performed on the trade.

ID

Ext Ref

Int Ref

Unique identification of the trade. The trade ID is automatically assigned by the system when the trade is
saved.

You can load an existing trade by typing the trade ID into this field and pressing the Enter key.

You can also display the internal reference or external reference. The default trade reference to be
displayed can be selected in the User Defaults.

The internal and external reference can be set on the Details tab of the Trade worksheet.

Template You can select a template from the Template field to populate the worksheet with default values. Modify
the fields as necessary.

Mirror Check to generate a mirror trade. You will be prompted to enter additional fields in the Contract Details.

See Portfolio Swap Mirror Trades for details.

Contract Details Fields

Fields Description

Trade Date Enter the trade date. Double-click the plus sign (+) to make Trade Time and Current options available.
Select the Current checkbox to use the current date and time.

Contract The contract is automatically displayed based on the Processing Organization of the selected trade
book, the counterparty, and the trade date.

If several contracts have the same Processing Organization and Counterparty, no contract will be
chosen by default. The user will be able to select the contract from a list of contracts active at trade
date.

 Ⓘ [NOTE: There must be a saved Portfolio Swap contract whose legal entities and roles match
those selected in the trade window before you can select the contract in the Portfolio Swap
Contracts search window]

You can click to view the contract details.

Start Date Effective date of the underlying contract.

End Date End date of the underlying contract.

Commission The commission fee rate in bps defaulted from the underlying contract. The user can override the

Nasdaq Calypso
Portfolio Swaps / Version 18



Fields Description

default value.

Commission
Pay Method

Commission pay method of the underlying contract.

Pay Accruals
at
Liquidation

Accruals payment at liquidation method for the underlying contract.

Trading Gain
Pay Method

Trading gain pay method of the underlying contract.

Settlement
Currency

Settlement currency of the underlying contract.

FX
Conversion
Method

FX conversion method of the underlying contract.

Basic
Interest Rate
(%)

Basic interest rate of the underlying contract.

Equity Leg Details

Fields Description

Direction Direction of the leg from the Processing Organization's perspective. Select either Pay or Receive.

Underlying Select the underlying product.

You can click to view the underlying details.

Quantity Enter the number of shares.

Gross Price Enter the negotiated trade price.

Initial Price Calculated by the system. In the case of Embedded Commission Pay Method, the commission rate /
price is included in the Initial Price. In any other case, the Initial Price is equal to the Gross Price. This
price is used to calculate the first payoff of a swap.

Spot (Current
Level)

Displays the current market price.

Initial FX Rate When the settlement currency is different from the contract currency, you can set the initial FX rate in
this field.

Initial Price
(Settle Ccy)

This field is displayed when the settlement currency is different from the contract currency and the
FX Conversion Method is Compo. It is defined as the initial price converted into settlement currency
using the Initial FX Reset of the trade.
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Fields Description

FX Reset When the settlement currency is different from the contract currency, the FX Reset Reference as
defined in the underlying contract is displayed here.

Performance
Schedule

Displays the performance payoff schedule of the underlying contract.

Dividend
Schedule

Displays the dividend payment schedule of the underlying contract.

Retrocession
Rate (%)

Retrocession Rate corresponds to Dividend Receivable percentage or Dividend Payable percentage
from the underlying contract.

Funding Leg Details

Fields Description

Direction Pay or Receive. The selection is based on the performance leg's direction.

Initial
Notional

Initial funding notional in pricing currency. Pricing currency is underlying the underlying security
currency for the Flexo conversion method. Pricing currency is settlement currency for the Compo
conversion method.

Include
Cash
Prepaid

Displays the value entered in the contract

Borrow
Charge
Rate (Fixed
%)

Borrow charge rate of the underlying contract.

The borrow charge rate can be seen in the Trade Browser in the following columns:

• "Borrow Charge Rate (%)" - Borrow charge rate as of valuation date

• "SettleDateBorrowCharge" - Borrow charge rate as of trade start date

Leg Type Fixed or Float (based on the underlying contract).

Fixed Rate
(%)

For a fixed leg, displays the fixed rate of the underlying contract by default.

You can click to enter a fixed rate schedule.

Spread (%) Displays the funding spread of the underlying contract by default using the latest version of the country
grid. You can see the version number in the trade keyword PortfolioSwapPositionSpreadVersion. If you
customize the spread at the trade level, the version number is increased and prefixed with "-" to
indicate it is customized.

You can click to enter a spread schedule if the contract allows.
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Fields Description

» Add rows as needed.

» You can check "Lock Trade Funding Spreads" to lock the spreads at trade level.

» Click Okwhen you are done.

The spread as of trade start date can be displayed in the Trade Browser in the column
"SettleDateSpread".

Rate Index For a floating leg, select the rate index: currency, reference index, tenor, and source (from the
underlying contract).

You can also set the following parameters:

• Index Factor

• Spread (%) - You can click to enter a spread schedule.

• Reset lag

• Reset timing

• First Reset (%)

• Compounding

• Averaging reset

• Different Reset Dates Per Coupon

DayCount Displays the daycount from the underlying contract.

Coupon
Schedule

Displays the coupon schedule from the underlying contract.

Frequency Displays the funding payment frequency from the underlying contract.

Stub Rule Displays the stub rule defined in the underlying contract.

Period Rule Displays the period rule from the underlying contract.

Payment
Date Lag

Displays the payment date lag from the underlying contract.
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2.2 Specifying Addit ional Detai ls
Select the Details tab to modify trade details.

» You can click Bundles to associate the Portfolio Swap trade with a bundle. You will be prompted to select a
bundle.

Field Details

Fields Description

Trader Select a Trader.

Click ... to add new traders. You will be prompted to enter a new trader name.

Sales Select a Sales Person.

Click ... to add a new sales person. You will be prompted to enter a new sales person name.

Action Shows the action currently performed on the trade based on the workflow configuration.

You can select an action that will be applied on the trade upon saving as applicable.

Status Status of the trade.

Market Select None, Primary, Re-Issue, Secondary, or When-Issued.
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Fields Description

Type

Subsidiary Click ... to select a subsidiary. The Legal Entity Chooser will appear. You will prompted to select a legal
entity for the role of subsidiary.

StepIn
Transferor

Transferor from a Step-In Novation done through DTCC.

Calc Agent Click ... to select a calculation agent. The calculation agent is the party who acts as the referee in the
event of a disagreement about a payment detail. The calculation agent will be designated in a legal
agreement.

Comment Enter a comment as applicable.

Mirror See Portfolio Swap Mirror Trades.

Internal Ref Enter an internal reference for the trade as needed.

It can be used for reporting purposes, and you can search trades using their internal reference
throughout the system.

You can set the environment property AUTO_FEED_INTERNAL_REF to true to automatically populate the
internal reference with the ID of the original trade for trades created through partial termination and
novation, else with the trade ID.

External
Ref

Enter an external reference for the trade as needed.

It can be used for reporting purposes, and you can search trades using their external reference
throughout the system.

You can set the environment property AUTO_FEED_EXTERNAL_REF to true to automatically populate
the external reference with value of the trade keyword TRANSFER_FROM if not empty, else with the
trade ID.

2.3 Capturing Trade Fees
The Fees tab allows entering fees for the trade. It also shows fees that have been automatically computed.
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» Select a fee type from the Type field or click ... to create a new fee type. The Fee Definition window will appear.

– Select PAY or REC next to the fee type as applicable. This indicates whether the processing org pays or
receives the fee to / from the recipient.

– Select the payment currency of the fee from the field next to the Amount field.

– Enter the payment date of the fee in the Fee Date field.

The fee date defaults to trade date + spot days (from the fee currency) + fee offset (from the fee definition).

For automatic fees, the fee date can be overridden by the attributes of the fee grid.

– Select the role of the fee recipient from the Role field and click ... next to the Legal Entity field to select the
fee recipient. The Legal Entity Chooser will appear. You will be prompted to select a legal entity of specified
role.

» Click Add to add a fee row or click Generate to amortize the fee over a given period.

When amortizing a fee, you will be prompted to enter a start date, end date, and amortization frequency.

» Click Apply to generate fee rows as applicable.

Fields Details

Fields Description

Amount Enter the fee amount for a flat fee only (method NONE). Otherwise, the amount will be calculated with
the designated method.

Method Select a fee calculation method and click Calc to calculate the fee. Keep in mind that the NONE method
does not require calculation.

When defining a fee type, you can select a default fee calculator.

Refer to the Calypso Developer's Guide for information on adding custom fee calculators.
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Fields Description

Click ? for information on a given method.

Start Date

End Date

Start Date and End Date will be set to the Fee Date, unless you choose to amortize the fee over a given
period.

Known Date Allows you to enter a fee for a given date when you choose to amortize the fee over a give period.

Enter a fee with a known date and click Add. A fee row will be added for the date. The known date must
be between the start and date.

Description Enter a comment as applicable.

2.4 Generat ing Cashflows
Select the Cashflows tab to display cashflows.

The cashflows are generated when you click Price on the Trade tab, or when you choose Cashflows > Generate.

2.4.1 Cashf lows Menu
The Cashflows menu items are described below.

The Cashflows menu is accessible from the Trade PortfolioSwap Window menu bar or by right-clicking a cashflow.

Menu Item Description

Generate To generate the cashflows.

 Ⓘ [NOTE: If you have customized the cashflows and not locked the columns containing
modified values, you should not choose Generate, because those columns will be overridden.
You should choose Recalc instead]

Recalc When cashflows have been customized, choose Recalc to display the cashflows without overriding
unlocked columns.

Copy Ctl-C To copy and paste into cashflow cells.
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Menu Item Description

Paste Ctl-V Select a cell, type [Ctrl+C], then select another cell and type [Ctrl+V]. The content of the first cell will
be pasted into the second cell.

Add Coupon To add a cashflow.

Right-click on a row and choose Add. The selected row will be split between two rows. The right one
will be one day long, and the second one will fit the remaining term of the original period. You can edit
the periods as applicable.

Remove
Coupon

To remove a cashflow.

Right-click and row and choose Remove. The selected row will be removed.

Add Coupon
Period

Remove
Coupon
Period

To add or remove compounding periods.

These menu items require customized cashflows and a compounding trade. Then you can add or
remove compounding periods.

Scheduler To define an amortization schedule for the principal.

Right-click one or multiple Notional cells, and choose Scheduler. It will bring up the Scheduler
Notional window.

Sample
Values

Lock Column To lock a customized cashflow.

Right-click a customized column and choose Lock Column. The values will not be overridden when
the cashflows are generated.

Lock All
Modified

Columns

To lock all customized columns.

Unlock
Column

To unlock a locked column.

Right-click a locked column and choose Unlock Column to unlock it.

Unlock All
Columns

To unlock all locked columns.

Configure
Columns

To select and organize displayed columns.

Save Column
Config

To save the column configuration.

Export to
Excel

To export the cashflows to an Excel spreadsheet.

Export to To export the cashflows to an HTML page.
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Menu Item Description

HTML

Show
Consolidated
Cashflows

To bring up the Cashflow Report that displays all the cashflows associated with the trade.

Portfolio Swaps should be liquidated using FIFO by trade date.

Each trade has its own trade costs like Accrual Buy/ Accrual Sell / Basic Interest Buy / Basic Interest Sell / Borrow
Charge. These carry the accrual from the last cashflow start date until the settle date of the deal - PERFORMANCE,
FUNDING_CHARGE_REALIZED, SERVICE_CHARGE_REALIZED, BORROW_CHARGE_REALIZED. They are generated by
the liquidation process.

In order to generate TRADING_GAIN and PERFORMANCE transfers on aggregated positions per product type, and to
exclude some product types from Liquidation Aggregation, you can use the following domains:

• “XferPosAggregation.Exclude” – Add the product types for which you do not want to generate TRADING_GAIN
and PERFORMANCE transfers on aggregated positions.

• “XferLiquidationConfig” – Add the product types and liquidation configurations for which you want TRADING_
GAIN and PERFORMANCE transfers to be generated.

Example: PortfolioSwap.DEFAULT

Position details and basic interest, borrow charge, and funding accrual calculations can be viewed in the Position
Valuation Report.

 See Position Valuation Report for details on configuring and using the report.

2.4.2 BASIC INTEREST
Basic Interest flows are part of the service charges paid by the user of the portfolio swap to the provider (provider can
be the prime broker). These flows are paid by the user regardless of the direction of the position. The schedule is the
same as the funding schedule defined on the contract level. The rate is fixed and is the same for long and short
positions.

If FX Conversion Method = Compo:

BASIC_INTEREST =Position Notional * (Basic Rate) * Period

• Position Notional = Position Open Quantity * Avg Cost Price

• Avg Cost Price is in settlement ccy = Avg cost Price in underl ccy * FX Reset
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If FX Conversion Method = Flexo:

BASIC_INTEREST =Position Notional * (Basic Rate) * Period

• Position Notional = Position Open Quantity * Avg Cost Price

• The User of the portfolio swap contract will always be the payer of this flow regardless the direction of the trade.

Formula for CA trade with Counterparty (BO transfer amount):

BASIC_INTEREST =Position Notional * (Basic Rate) * Period * FX Reset

• Position Notional = Position Open Quantity * Avg Cost Price

• The User of the portfolio swap contract will always be the payer of this flow regardless the direction of the
position.

• FX Rate Reset Date = Payment date – FX reset date lag (defined on the FX Rate Definition)

2.4.3 FUNDING CHARGE
If the “Include Cash Prepaid” checkbox is selected in Funding Leg Details of the Portfolio Swap contract, the funding is
calculated on the contract position level. It takes into account the margin call position.

FUNDING_CHARGE_REALIZED = Funding Notional * (Funding Rate + Short Funding Spread) * Period

• Case 1: PO = Provider of the Portfolio Swap contract. PO will receive the FUNDING regardless the direction of the
position.

Funding Notional = MAX (0; Short Positions Notional – Margin Call Position + Long Positions Notional * Initial
Margin Ratio)

Short and Long Positions Notional = Position Open quantity * Avg Cost Price * Avg Cost FX

FX Conversion is done on the pricing and PL level only if FX conversion method of the contract is Compo

• Case 2: PO = User of the Portfolio Swap contract. PO will pay the FUNDING regardless the direction of the
position.

Funding Notional = MAX (0; Long Positions Notional – Margin Call Position + Short Positions Notional * Initial
Margin Ratio)

Short and Long Positions Notional = Position Open quantity * Avg Cost Price * Avg Cost FX

FX Conversion is done on the pricing and PL level only if FX conversion method of the contract is Compo.

Funding notional will be adjusted on each fixing date of the performance leg.
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If the “Include Cash Prepaid” checkbox is cleared in the Portfolio Swap contract, the funding is calculated on the
contract / underlying security position level. It does not take into account the margin call position. The funding will be
paid by the Processing Organization on long positions and received on the short positions.

FUNDING_CHARGE_REALIZED = Funding Notional * (Funding Rate + Short or Long Funding Spread) * Period

• Funding Notional = Position Open quantity * Avg Cost Price * Avg Cost FX

FX Conversion is done on the pricing and PL level only if FX conversion method of the contract is Compo

Funding notional will be adjusted on each fixing date of the performance leg.

2.4.4 BORROW CHARGE
The Borrow Charge is paid by the user of the Portfolio Swap on long positions.

BORROW_CHARGE_REALIZED = Position Notional * (Borrow Charge Rate + Spread) * Period

• Case 1: PO = Provider of the Portfolio Swap contract. PO will receive the BORROW_CHARGE_REALIZED on all long
positions. There will be no BORROW_CHARGE_REALIZED flows on short positions.

Position Notional = Long Position Open Quantity * Avg Cost Price

Avg Cost Price is in settlement ccy = Avg cost Price in underl ccy * FX Reset

FX Conversion is done on the pricing and PL level only if FX conversion method of the contract is Compo.

• Case 2: PO = User of the Portfolio Swap contract. PO will pay BORROW_CHARGE_REALIZED on all short positions.
There will be no BORROW_CHARGE_REALIZED flows on long positions.

Position Notional = Short Position Open Quantity * Avg Cost Price

Avg Cost Price is in settlement ccy = Avg cost Price in underl ccy * FX Reset

FX Conversion is done on the pricing and PL level only if FX conversion method of the contract is Compo.

2.4.5 PERFORMANCE FLOWS
Compo FX Conversion method:

PRICE_CHANGE = Position Quantity * (Start Market Price * Start FX Rate – End Market Price * End FX Rate)

Position Quantity = open quantity of the position

Position Open Quantity is updated at each liquidation, and the funding notional is impacted accordingly.

Flexo FX Conversion method:

PRICE_CHANGE = Position Quantity * (Start Market Price – End Market Price)

Position Quantity = open quantity of the position
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The BO transfer will be converted into the settlement currency using the quote of the FX Reset Reference on the
payment date – Reset Days of the corresponding FX Reset Definition.

Position Open Quantity is updated at each liquidation, and the funding notional is impacted accordingly.

2.4.6 DIVIDEND FLOWS
DIVIDEND = Position Open Quantity * Dividend Amount % * Retrocession Rate * FX Rate

2.5 Portfol io Swap Trade Al location
The Allocation window allows allocating a trade to multiple books or multiple legal entities. When allocating a trade
(referred to as a block trade), child trades are created for each book or legal entity to which the block trade is
allocated. The allocation can be accomplished manually or according to an allocation template. The allocation is
performed based on a percentage of the notional amount (or quantity) of the block trade.

To allocate trades from the portfolio swap trade window, go to Back Office > Allocate. Alternatively, you can apply the
ALLOCATE action in a Trade Browser / Task Station.

» Click to add a row or to remove a row.

» In the Allocate by: drop-down list, indicate whether the allocation is specified by Legal Entity, Book/Strategy, or
Book.

» Enter details in the fields to define the allocation.

Allocation by Legal Entity
The Allocation window allows allocation by legal entity and an associated portfolio swap contract. Keep in mind the
following requirements.

• The processing organization in the initial trade should be the processing organization in the contract.
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• The counterparty or counterparties selected for allocation should be counterparty in contracts associated with
the allocation.

• The trade date of the initial trade should fall within the contract period.

Allocation by Book/Strategy or Book
The Allocation can also be specified by a book and portfolio swap contract or a book/strategy and contract. Keep in
mind the following requirements.

• The processing organization connected to the book selected in the allocation should be the processing
organization in the contract.

• The counterparty associated with the contract should be the counterparty on the initial trade.

• The trade date of the initial trade should fall within the contract period.

Refer to the Calypso documentation Allocating Trades for more information on trade allocation.

2.6 Portfol io Swap Mirror Trades
Mirror trades involve one Portfolio Swap trade between a processing organization and counterparty, and a mirror
trade between the original processing organization and other legal entity.

A mirror trade requires a Portfolio Swap contract between parties for both the original trade and the mirror trade.

» To initiate a mirror trade, select the Mirror checkbox in the upper left corner of the trade window. Mirror trade
options appear in the Contract Details panel.

» Select the Mirror Book. If the original trade's counterparty is different from the legal entity associated with the
mirror book, the following warning message appears. Click OK to accept the change to counterparty.
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» Select the Mirror Contract. Click to open the Portfolio Swap Contract window, or click in the Mirror Contract
field and then the down arrow to open the Portfolio Swap Contracts search window.

Contracts made available by the search are those whose processing organization is associated with the mirror
book or whose counterparty is the processing organization for the original trade's book.

Once the mirror trade is saved, two "child" trades are created. The following considerations apply:

• Details for each trade correspond to the contract and trade direction.

• Corporate actions (funding, price change, basic interest, borrow charges, dividend, and split) are applied on both
positions.

• Back office transfers and accounting are done on positions for both books.

• Commission fees, if any, are generated on both trades according to the Portfolio Swap contract details.

• Official P&L and Risk can be run for positions on both books.

After the trade is saved, the ID of the mirror trade will appear next to the Mirror checkbox.

If you add trade keywords to theMirrorKeywords domain, when these trade keywords are populated on the original
trades, they will be saved on the mirror trades as well.

Upon saving, two trades will be saved, and two tasks will be created, one for each trade. This is the default behavior
with the environment property MIRROR_WORKFLOW = true. So after the trades are saved, the mirror trade will be
independent from the original trade and will follow its own workflow.

If you set MIRROR_WORKFLOW = false, two trades will be saved, but only one task will be created. So from the point
of view of the workflow you will see one trade, and any modification to one of the trades will be automatically
propagated to the other. The task will be updated accordingly, whether you modify the original trade or the mirror
trade.

2.7 Portfol io Swap Corporate Actions

Please refer to Calypso Portfolio Swaps Corporate Actions documentation for details.
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3. Position Valuation Report
The Position Valuation Report displays information on a trade's position including basic interest, borrow charges, and
funding accruals.

The Position Valuation Report currently supports the product types Portfolio Swap and Equity.

From Calypso Navigator point to Position & Risk > Position Valuation Report (menu action
reporting.ReportWindow$portfolioswap.PortfolioSwapValuation) to open the Position Valuation Report
window.

Position Valuation Report window

» Point to View > Show Frame > Criteria to show the Criteria search frame. On the right side of the frame, you can
click to remove the search criteria frame from the report window.

Specify the search criteria by using the filters.

» Specify the pricing environment and valuation date at the bottom of the report window.

By default, the pricing details are current:

– The pricing environment defaults to the one set in the User Defaults.

– The valuation date is the current date and time.
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You can click the down arrow to change the default values.

» Click to load the report and view results.

» You can click to clear items in the report panel and any templates that were used to generate results.

» You can select a template and click to display the number of objects that will be loaded from the database
before loading the report.

» You can click to print the report results.

Configuring Columns
To select which elements and measures appear in the report, point to Data > Configure Columns to open the
Configure Columns window.

» Move elements to the Selected Elements field and click the OK button to show those columns in the report.

» To save search and column configuration as a template, point to Report > Save as Template. Point to Report >
Load Template to open a configuration in the report window.

» Confirm search criteria and click to load the associated results.
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